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INFORMATION MANAGEMENT AND 
SYNCHRONOUS COMMUNICATIONS 

SYSTEM WITH MENU GENERATION, AND 
HANDWRITING AND VOICE 
MODIFICATION OF ORDERS 

The present application is a continuation-in-part of appli­
cation Ser. No. 09/400,413, filed Sep. 21, 1999 now U.S. 
Pat. No. 6,384,850. The contents of application Ser. No. 
09/400,413 are incorporated herein by reference. 

FIELD OF THE INVENTION 

This invention relates to an information management and 
synchronous communications system and method for gen­
eration of computerized menus for restaurants and other 
applications with specialized display and synchronous com­
munications requirements related to, for example, the use of 
equipment or sore with non-PC-standard graphical formats, 
display sizes and/or applications for use in remote data entry, 
information management and synchronous communication 
between host computer, digital input device or remote pager 
via standard hardwired connection, the internet, a wireless 
link, smart phone or the like. 

BACKGROUND OF THE INVENTION 

While computers have dramatically altered many aspects 
of modern life, pen and paper have prevailed in the hospi­
tality industry, e.g., for restaurant ordering, reservations and 
wait-list management, because of their simplicity, ease of 
training and operational speed. For example, ordering pre­
pared foods has historically been done verbally, either 
directly to a waiter or over the telephone, whereupon the 
placed order is recorded on paper by the recipient or 
instantly filled. 

Although not previously adapted for wide-scale use in the 
hospitality industry, various forms of digital wireless com­
munication devices are in common use, e.g., digital wireless 
messengers and pagers. Also in common use are portable 
laptop and handheld devices. However, user-friendly infor­
mation management and communication capability not 
requiring extensive computer expertise has not heretofore 
been available for use in everyday life such as for restaurant 
ordering, reservations and wait-list management, Hundreds 

2 
solution to the ordering/waitlistlreservation problem dis­
cussed above. With the advent of the Palm® and other 
handheld wireless devices, however, the efforts to make such 
devices ubiquitous have begun to bear fruit at least in some 

5 areas, e.g., personal calendars. However, substantial use of 
such devices in the restaurant and hospitality context has not 
occurred to date. As discussed above, at least one of the 
reasons PDAs have not been quickly assimilated into the 
restaurant and hospitality industries is that their small dis-

10 play sizes are not readily amenable to display of menus as 
they are commonly printed on paper or displayed on, e.g., 
large, color desktop computer screens. Another reason is that 
software for fully realizing the potential for wireless hand­
held computing devices has not previously been available. 

15 Such features would include fast and automatic synchroni­
zation between a central database and multiple handheld 
devices, synchronization and communication between a 
World Wide Web ("Web") server and multiple handheld 
devices, a well-defined application program interface 

20 ("API") that enables third parties such as point of sale 
("POS") companies, affinity program companies and inter­
net content providers to fully integrate with computerized 
hospitality applications, real-time communication over the 
internet with direct connections or regular modem dialup 

25 connections and support for batch processing that can be 
done periodically throughout the day to keep multiple sites 
in synch with the central database. A single point of entry for 
all hospitality applications to communicate with one another 
wirelessly has also previously been unavailable. Such a 

30 single point of entry would work to keep all wireless 
handheld devices and linked Web sites in synch with the 
backoffice server (central database) so that the different 
components are in equilibrium at any given time and an 
overall consistency is achieved. For example, a reservation 

35 made online would be automatically communicated to the 
backoffice server and then synchronized with all the wireless 
handheld devices wirelessly. Similarly, changes made on 
any of the wireless handheld devices would be reflected 
instantaneously on the backoffice server, Web pages and the 

40 other handheld devices. 

of millions of dollars have been spent on personal digital 45 

assistant ("PDA") development seeking to produce a small, 
light-weight and inexpensive device that could be adapted to 
such uses; yet none have yielded a satisfactory solution. 

For the foregoing reasons, paper-based ordering, waitlist 
and reservations management have persisted in the face of 
widespread computerization in practically all areas of com­
merce. At most, computerization of these functions has been 
largely limited to fixed computer solutions, i.e., desktop or 
mainframe, because of the problems heretofore faced in 
configuring wireless handheld devices and maintaining data­
base synchronization for such applications. Specifically, the 
unavailability of any simple technique for creating restau-One of the inherent shortcomings of PDA type devices is 

that, as they strive for small size, low weight and low cost, 
they must compromise the size and clarity of the operator 
display medium interface itself, which in most cases is one 
of a variety of LCD (liquid crystal display) type devices. As 
the size of the display shrinks, the amount of information 
that may be displayed at anyone point or time is commen­
surately decreased, typically requiring multiple screens and 
displays to display information to the operator. This reduces 
the overall utility of the device. Additionally, the smaller 
display and keyboard results in a non-optimal operator 
interface, which slows down operation and is thus unaccept­
able for the time criticality of ordering, reservation and 
wait-list management and other similar applications. This 
necessitates many design compromises which in the aggre­
gate have resulted in limited acceptance of PDA type 
devices in the restaurant and hospitality fields. 

Many of the negatives prevalent in earlier devices have 
been eliminated, but, to date, there is still no integrated 

50 rant menus and the like for use in a limited display area 
wireless handheld device or that is compatible with ordering 
over the internet has prevented widespread adoption of 
computerization in the hospitality industry. Without a viable 
solution for this problem, organizations have not made the 

55 efforts or investments to establish automated interfaces to 
handheld and Web site menus and ordering options. 

A principal object of the present invention is to provide an 
improved information management and synchronous com­
munications system and method which facilitates user-

60 friendly and efficient generation of computerized menus for 
restaurants and other applications that utilize equipment 
with non-PC-standard graphical formats, display sizes and/ 
or applications. 

A further object of the present invention is to provide an 
65 improved information management and synchronous com­

munications system and method which provides for entry, 
management and communication of information from the 
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operator as well as to and from another computer, Web page 
menu, remote digital device using a standard hardwired 
connection, the internet or a wireless linle 

A further object of the present invention is to provide an 
improved information management and synchronous com­
munications system which is small, affordable and light­
weight yet incorporates a user-friendly operator interface 
and displays menus in a readily comprehensible format. 

A further object of the present invention is to provide a 
synchronous information management and communications 
system which enables automatic updating of both wireless 
and internet menu systems when a new menu item is added, 
modified or deleted from any element of the system. 

SUMMARY OF THE INVENTION 

The foregoing and other objects of the present invention 
are provided by a synchronous information management and 
communications system and method optimized for simplic-

4 
ally communicated and exchanged. The resultant combined 
message of one or more fixed indications selected from a 
menu of a device such as a band-held, and dynamic hand­
written messages and/or data provides an even more pow-

5 erful tool than either modality used independently. 
For example a restaurant server taking a drink order could 

select from a menu of her hand-held device's screen "Iced 
Tea", and then manually write in the literal screen of her 
hand-held "with lemon" as shown in FIG. 8. The manually-

10 written information could, for example, be printed or dis­
played in front of a bartender preparing the drink order. The 
indication "Iced Tea" as selected from a menu of the 
hand-held would also be presented to the bartender, perhaps 
by printing and/or screen display. The server can also select 

15 any printer from within the hospitality establishment directly 
from the operator interface on the screen of the hand-held 
and have either the order or the receipt printed out where it 
is most convenient and efficient Similarly, a server taking a 
drink order could select from a menu of her hand-held 

ity of operation which incorporates menu generation for 20 

creation of menus to be used with wireless remote handheld 
device's screen "Iced Tea", and then record the voice 
message "with lemon" using her hand-held device integral 
microphone. The recorded information could, for example, 
be played on a speaker attached to a computer, POS system, 
or the like located near the bartender or chef preparing the 

computer and PDA devices, the internet or any application 
where simple and efficient generation of menus is appropri­
ate. The menu generation approach of the present invention 
includes a desktop software application that enables the 
rapid creation and building of a menu and provides a means 
to instantly download the menu configuration onto, e.g., a 
handheld device or Web page and to seamlessly interface 
with standard point of sale ("POS") systems to enable 
automatic database updates and communication exchanges 
when a change or input occurs in any of the other system 
elements. To solve the above and other related problems, an 
information management and communications system is 
provided which results in a dramatic reduction in the amount 
of time, and hence cost, to generate and maintain comput­
erized menus for, e.g., restaurants and other related appli­
cations that utilize non-PC-standard graphical formats, dis­
play sizes or applications. 

25 order. The indication "Iced Tea" as selected from a menu of 
the hand-held would also be presented to the bartender/chef, 
perhaps by printing and/or screen display. Both the literal 
screen capture method and the voice recorded message 
method combine the power of automatic fixed menu gen-

30 eration with the expanded flexibility to resolve operational 
issues that exist throughout the hospitality market without 
this innovative solution. Additionally, in certain 
embodiments, hand-writing and voice recognition technolo­
gies can be utilized to convert the manual operator inputs 

35 into appropriate text messages which can be combined with 
the computer generated menu options to convey the com­
bined information to, for example, a bartender or chef. 

Similarly, hand-held devices can link the above innova­
tions to individual customers at specific tables through a The menu generation approach of the present invention 

has many advantages over previous approaches in solving 
the problem of converting paper-based menus or Windows® 
PC-based menu screens to small PDA-sized displays and 
Web pages. In one embodiment, the present invention is a 
software tool for building a menu, optimizing the process of 
how the menu can be downloaded to either a handheld 
device or Web page, and making manual or automatic 
modifications to the menu after initial creation. 

40 graphical user interface on the hand-held screen that assigns 
each customer a number within a table. For example, table 
20 might have 6 customers (1-6) and each customer has a 
different order, By enabling the linkage of the orders to 
specific customer positions within the table and accessible 

45 from the hand-held screen, the servers can easily track and 
link the specific orders to the specific customers. 

Manual modifications to the generated menus include 
handwritten screen captures and/or voice recorded message 
captures coupled with the standard menus and modifiers 50 

generated according to standard choices . Such manual 
modifications enable an extremely rapid and intuitive inter­
face to enhance operations and further optimize the overall 
operator interface. This approach solves a long-standing, 
operational issue in restaurantlhotel/casino food/drink order- 55 

ing when customers want something unusual and not antici­
pated and available through normal computerized selections. 
As seen in FIG. 8, the operator screen on the hand-held can 
capture handwritten information specific to a customers 
requests directly on the touch-sensitive screen of the wire- 60 

less computing device. This additional information can then 
be coupled with the fixed menu and modifier information 
generated automatically from the hospitality application 
software and the combined message can be sent to a res­
taurant point of sale (POS) system, printer or/or display 65 

system. This unique operator interface enables universal 
languages and an unlimited set of information to be manu-

The use of wireless handheld devices in the restaurant and 
hospitality industry is becoming increasingly pervasive as 
restaurant owners and managers become more aware of the 
benefits. With the proper wireless handheld system in place, 
restaurants can experience increased table turns from 
improved server productivity and shorter order taking and 
check paying times. Restaurants and POS companies seek­
ing to provide a wireless handheld interface to their desktop­
based POS systems or a Web page equivalent face several 
challenges. These challenges include building a menu using 
their existing database and transferring the menu onto hand­
held devices or Web pages that will interface with servers 
wirelessly or to restaurants/customers over the internet The 
menu generation approach of the present invention is the 
first coherent solution available to accomplish these objec-
tives easily and allows one development effort to produce 
both the handheld and Web page formats, link them with the 
existing POS systems, and thus provides a way to turn a 
complicated, time-consuming task into a simple process. 

The information management and synchronous commu­
nications system of the present invention features include 
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fast synchronization between a central database and multiple 
handheld devices, synchronization and communication 
between a Web server and multiple handheld devices, a 
well-defined API that enables third parties such as POS 
companies, affinity program companies and internet content 5 

providers to fully integrate with computerized hospitality 
applications, real-time communication over the internet with 
direct connections or regular modem dialup connections and 
support for batch processing that can be done periodically 
throughout the day to keep multiple sites in synch with the 10 

central database. 

FIG. 9 is an exemplary system diagram relating to 
embodiments of the present invention. 

DETAILED DESCRIPTION OF THE 
INVENTION 

Most personal computers today run under an operating 
system that provides a graphical user interface ("GUI") for 
accessing user applications. A GUI is used in the preferred 
embodiment of the present invention. Through an interface 
of windows, pull-down menus, and toolbars, GUI operating 
systems have simplified PCs and have rendered computer 

The communication module also provides a single point 
of entry for all hospitality applications, e.g., reservations, 
frequent customer ticketing, wait lists, etc. to communicate 
with one another wirelessly and over the Web. This com­
munication module is a layer that sits on top of any com­
munication protocol and acts as an interface between hos­
pitality applications and the communication protocol and 
can be easily updated to work with a new communication 
protocol without modifying the core hospitality applications. 
An exemplary system diagram of such a communications 
systemic relationship is shown in FIG. 9 and serves as an 
example of the power of the synchronization element of the 
invention through a common, linked solution. A single point 
of entry works to keep all wireless handheld devices and 
linked web sites in synch with the backoffice server appli­
cations so that the different components are in equilibrium at 
any given time and an overall consistency is achieved. For 
example, a reservation made online can be automatically 
communicated to the backoffice server and then synchro­
nized with all the wireless handheld devices wirelessly. 
Similarly, changes made on any of the wireless handheld 
devices are reflected instantaneously on the backoffice 
server Web pages and the other handheld devices. 

BRIEF DESCRIPTION OF THE DRAWINGS 

The foregoing features and advantages of the present 
invention can be appreciated more fully from the following 
description, with references to the accompanying drawings 
in which: 

FIG. 1 is a schematic representation of a window dis­
played on a computer display screen which shows a hierar­
chical tree menu, modifier window and sub-modifier win­
dow in conformity with a preferred embodiment of the 
present invention. 

FIG. 2 is a schematic representation of a modifier dialog 
box in conformity with a preferred embodiment of the 
present invention. 

FIG. 3 is a schematic representation of a menu category 
dialog box in conformity with a preferred embodiment of the 
present invention. 

FIG. 4 is a schematic representation of a menu item dialog 
box in conformity with a preferred embodiment of the 
present invention. 

FIG. 5 is a schematic representation of a display customi­
zation dialog box in conformity with a preferred embodi­
ment of the present invention. 

FIG. 6 is a schematic representation of a communications 
control window in conformity with a preferred embodiment 
of the present invention. 

FIG. 7 is a schematic representation of a point of sale 
interface on a wireless handheld device for use in displaying 
page menus created in conformity with a preferred embodi­
ment of the present invention. 

FIG. 8 is an example of a literal, hand-written screen 
according to embodiments of the present invention. 

technology more user friendly by eliminating the need to 
memorize keyboard entry sequences. In addition, GUIs 
allow users to manipulate their data as they would physical 

15 entities. For example, a window can represent a file and the 
contents of the window can represent the records of the file. 
The window can be opened, closed, or set aside on a desktop 
as if it were an actual object. The records of the file can be 
created, deleted, modified and arranged in a drag-and-drop 

20 fashion as if they also were physical objects. The most 
common GUI operating systems that provide this "object­
oriented" environment for personal computers are Microsoft 
Windows® systems, including Windows CE® for handheld 
wireless devices and the like. Generally, a particular appli-

25 cation program presents information to a user through a 
window of a GUI by drawing images, graphics or text within 
the window region. The user, in turn, communicates with the 
application by "pointing" at graphical objects in the window 
with a pointer that is controlled by a hand-operated pointing 

30 device, such as a mouse, or by pressing keys on a keyboard. 
The use of menus is conventional in GUIs for software 

applications. Menus are typically utilized to provide end 
users of applications with available choices or processing 
options while using the applications. For example, in a 

35 typical desktop or interactive application, selection of a 
"file" from a menu bar may cause display of a context menu 
which provides "file" options. File options can have addi­
tional subordinate or child options associated with them. If 
a file option having subordinate options is selected, the child 

40 options are displayed in context in a child menu or submenu 
proximate to the selected parent option. One or more of the 
child options provided in the child menu may have further 
subordinate options. Thus, such a menu system comprises 
cascading sets of menus which are displayable in context to 

45 show the parent/child relationships between options of the 
context menu. A menu system of this type is incorporated 
into the preferred embodiment of the invention. The pre­
ferred embodiment of the present invention uses typical 
hardware elements in the form of a computer workstation, 

50 operating system and application software elements which 
configure the hardware elements for operation in accordance 
with the present invention. A typical workstation platform 
includes hardware such as a central processing unit 
("CPU"), e.g., a Pentium® microprocessor, RAM, ROM, 

55 hard drive storage in which are stored various system and 
application programs and data used within the workstation, 
modem, display screen, keyboard, mouse and optional 
removable storage devices such as floppy drive or a CD 
ROM drive. The workstation hardware is configured by 

60 software including an operating system, e.g., Windows® 95, 
98, NT or CE, networking software (including internet 
browsing software) and application software components. 
The preferred embodiment also encompasses a typical file 
server platform including hardware such as a CPU, e.g., 

65 Pentium® microprocessor, RAM, ROM, hard drive, 
modem, and optional removable storage devices, e.g., floppy 
or CD ROM drive. The server hardware is configured by 
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software including an operating system, e.g., Windows® 95, 
98, NT or CE, networking software (including Web server 
software) and database software. 

A computer workstation for use in the preferred embodi­
ment also includes a GUI. As is conventional, the GUI is 5 
configured to present a graphical display on the display 
screen arranged to resemble a single desktop. Execution of 
an application program involves one or more user interface 
objects represented by windows and icons. Typically, there 
may be several windows and icons simultaneously present 10 

on the desktop and displaying information that is generated 
by different applications. The window environment is gen­
erally part of the operating system software that includes a 
collection of utility programs for controlling the operation of 

8 
files are stored on a PC with folders and sub folders. The 
menu structure is similar to the Windows® File Explorer in 
the way the items are organized hierarchically. Below is an 
example of how an item may be configured: 

Menu 
» Entrees 

» Red Meat 
» NY Strip 

» Vegetables 
» Tomato 
» Lettuce 
Meat Temperature 
» Medium Rare 

the computer system. The computer system, in turn, interacts 15 -----------------------­
with application programs to provide higher level 
functionality, including a direct interface with the user. 
Specifically, the application programs make use of operating 
system functions by issuing task commands to the operating 
system which then performs the requested task. For 20 

example, an application program may request that the oper­
ating system display certain information on a window for 
presentation to the user. 

An aspect of the preferred embodiment of the information 
management and communications system of the invention is 25 

shown in FIG. 1. FIG. 1 shows an example of the GUI 
provided by the operating system of the preferred embodi­
ment of the present invention. With reference to FIG. 1, the 
preferred embodiment includes an intuitive GUI I from 
which to build a menu on a desktop or other computer. A 30 

hierarchical tree structure 2 is used to show the different 
relationships between the menu categories 3 (e.g., soups, 
salads, appetizers, entrees, deserts, etc.), menu items 4 (e.g., 
green salad, chicken caesar salad, etc.), menu modifiers 5 
(e.g., dressing, meat temperature, condiments, etc.) and 35 

menu sub-modifiers 6 (e.g., Italian, French, ranch, bleu 
cheese, etc.). 

The procedure followed in configuring a menu on the 
desktop PC and then downloading the menu configuration 
onto the POS interface on the handheld device in conform- 40 

ance with the preferred embodiment is as follows. 
The menu configuration application is launched by click­

ing on the appropriate icon on the desktop display screen. 
FIG. 1 will then be displayed. There are three windows on 
the screen shown in FIG. 1. The left window is the menu tree 45 

7, also called the tree view. The top right window is the 
Modifiers window 8 and the bottom right window is the 
Sub-Modifiers window 9. The Sub-Modifiers window lists 
the sub-modifiers that correspond to the modifier that is 
selected. The views on the right are referred to as list views. 50 

There are several ways of invoking a command, including 
using the menu options; using the context menu (right 
mouse click); using the keyboard or using the toolbar icons. 
For example, if it is desired to add a category to the menu, 
the following four options are available: (1) clicking on Edit, 55 

Add Category; (2) right mouse clicking on Menu, then 
clicking on Add Category; (3) highlighting Menu, then 
typing Ctrl+ T or (4) clicking on the Add Category icon on 
the toolbar. To add an item to a category, the following 
options are available: (1) highlighting the category to which 60 

it is desired to add an item and then clicking on Edit>Add 
Item; (2) right mouse clicking on the desired category and 
then clicking on Add Item; (3) highlighting the desired 
category, then typing Ctrl+N or (4) clicking on the Add icon 

In the above example, Menu is the root. Entrees is a menu 
category. Red Meat is an Entree category. NY Strip is a 
modifier. Vegetable is a modifier. Meat Temperature is a 
modifier. Medium Rare is a sub-modifier of Meat Tempera­
ture. 

The steps taken in building a menu are as follows: 
1. Add Modifiers; 
2. Add Sub-Modifiers and link them to the Modifiers; 
3. Create Menu categories; 
4. Add menu items to the categories; 
5. Assign Modifiers to the menu items; 
6. Preview the menu on the POS emulator on the desktop 

PC; 
7. Download the menu database to the handheld device. 
To add modifiers, a user clicks on the inside of the 

Modifiers window, then (1) clicks on Edit>Add Modifier, (2) 
Presses Ctrl+N; (3) right mouse clicks in the Modifiers 
window, then clicks on Add Modifiers or (4) clicks on the 
Add icon from the toolbar. If a menu is being built from 
scratch, the procedure is to enter the Long Name, Short 
Name, Code and Price in the Modifier dialog box 10 shown 
in FIG. 2. The Long Name is the fill descriptive name of the 
item. The Short Name is the abbreviated name that will be 
displayed on the handheld device. The Code is the numeric 
or alphanumeric code for the item. If there is an existing 
database, the existing database can be browsed and menu 
items retrieved from the database. Clicking on the Browse 
button will bring up the existing database of menu items. 
The item to be added is then selected and "OK" is clicked. 
The fields will then be filled with the information from the 
database. Clicking on OK again will add the item as a 
modifier. To delete a modifier, the modifier is selected and 
the Delete key pressed on the keyboard. To edit a modifier, 
either the modifier is double clicked or the Enter key is 
pressed. 

Sub-modifiers represent the last level of modifiers that can 
be assigned to a menu tree. To add sub-modifiers, the 
modifier to which sub-modifiers are to be assigned is 
selected. Then, the focus is set on the sub-modifier window 
by clicking inside the Sub-Modifier window as follows: (1) 
clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl+N; (3) 
right mouse clicking in the Sub-Modifiers window, then 
clicking on Add Sub-Modifiers or (4) clicking on the Add 
icon from the toolbar. If a menu is being built from scratch, 
the procedure is to enter the Long Name, Short Name, Code 
and Price in a Sub-Modifier dialog box similar to the 
Modifier dialog box shown in FIG. 2. As with modifiers, the 
Long Name is the full descriptive name of the item. The 
Short Name is the abbreviated name that will be displayed 

on the toolbar. 
When building a menu, it should be kept in mind that the 

menu items are stored using a tree metaphor similar to how 

65 on the handheld device. The Code is the numeric or alpha­
numeric code for the item. As before, if there is an existing 
database, the existing database can be browsed and menu 
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then be run. If the configuration is deemed acceptable, the 
handheld device is connected to the desktop PC to ensure 
that a connection has been established; the POS application 
on the handheld device is exited and File>Download Data-

items retrieved from the database. Clicking on the Browse 
button will bring up the existing database of menu items. 
The item to be added is then selected and OK clicked. The 
fields will then be filled with the information from the 
database. Clicking on OK again will add the item as a 
submodifier. To delete a sub-modifier, the sub-modifier is 
selected and the Delete key depressed on the keyboard. To 
edit a sub-modifier, either the sub-modifier is double clicked 

5 base is clicked on or the Download Database icon from the 

or the Enter key is pressed. 
Menu categories are created from the root. Some 10 

examples of categories are Appetizers, Soups, Salads, 
Entrees, Desserts, etc. The first step is to click on Menu in 
the menu tree window. Categories are added by (1) clicking 
on the Add Category icon from the toolbar; (2) clicking on 
Edit>Add Category or (3) pressing Ctrl+ T. As shown in FIG. 15 

3, Menu Category dialog box 11 then appears in which to 
enter the Long and Short names for the menu category. 

To add menu items to categories, the menu category 
which is being built is clicked. For example, if items are 
being added to Appetizers, the Appetizers branch is clicked 20 

on. Then the Edit>Add Item is clicked on or Ctrl+N pressed. 
As before, if a menu is being built from scratch, the 
procedure is to enter the Long Name, Short Name, Code, 
Prep Time, Recipe and Price into the Menu Item dialog box 
12 shown in FIG. 4. The Long Name is the full descriptive 25 

name of the item. The Short Name is the abbreviated name 
that will be displayed on the handheld device. The Code is 
the numeric or alphanumeric code for the item. Prep Time is 
the time it takes to prepare the meal and Recipe would 
include preparation methods and ingredients that are used in 30 

the preparation of the item. If there is an existing database, 
the existing database can be browsed and menu items 
retrieved from the database. Clicking on the Browse button 
will bring up the existing database of menu items. The item 
to be added is then selected and OK is clicked. The fields 35 

will then be filled with the information from the database. 
Clicking on OK again will add the item to the category. 

Once the menu items have been entered, it may be desired 
to assign some modifiers to the menu items. For example, it 
may be desired to assign meat temperature to a steak order. 40 

To accomplish this, first the modifier to be assigned is 
selected, then the menu item on the tree view that is to be 
assigned the modifier is clicked on and then Edit>Assign 
Modifier is clicked on. Or, the modifier can simply be 
dragged and dropped onto the menu item to link them. A 45 

dialog box is then displayed asking if this modifier is a 
required modifier. If it is a required modifier, the display 
icon will be red but if it is a non-required modifier the 
display icon will be green. As many modifiers as are 
applicable can be assigned. If any changes are made to the 50 

modifiers, those changes will be automatically reflected 
throughout the menu tree. 

Once the modifiers have been entered, it may be desired 
to assign sub-modifiers to the modifiers items. For example, 
it may be desired to add Honey Mustard as a sub-modifier 55 

to Dressing. To accomplish this, first the modifier to be 
assigned a submodifier is selected, then the sub-modifier 
window is clicked on, then Edit>Add Sub Modifier is 
clicked on, Ctrl+N entered or the Add icon from the toolbar 
is clicked on. Or, the sub-modifier can simply be dragged 60 

and dropped onto the modifier to link them. 
When the menu has been completely configured, it can be 

previewed on a POS emulator on the desktop to verify that 
the menu is correctly configured before downloading it to 
the handheld device. To preview, File>Preview Database is 65 

clicked on or the Preview Database icon from the toolbar is 
clicked on. The handheld POS emulator on the desktop can 

toolbar is clicked on. If there is an existing menu database 
on the handheld device, the system will ask if the existing 
database should be replaced. Yes is clicked if existing 
database replacement is desired. 

A database function enables the creation of, e.g., a break­
fast menu, lunch menu and dinner menu and downloading 
them to a handheld device. Functions available are (1) 
creating a new database; (2) opening an existing database; 
(3) saving a database under a different name. To access these 
functions, File is clicked on the menu bar. 

The preferred embodiment encompasses customized 
layout, views and fonts. To set the focus on the view it is 
desired to change, click inside the desired window. The main 
customizing dialog box is accessed by clicking on 
View>Customize View. A dialog box 13, as shown in FIG. 
5, will be displayed including tabs that allow the following 
options: selection of Columns to display in the list view by 
choosing and arranging the fields to display in the Modifiers 
and Sub-Modifiers windows; formatting Columns by speci­
fying the column widths and justification; selecting Filter 
allows restricting the list to display only the items that meet 
certain criteria. For example, display of modifiers with codes 
between 500 and 550. Selecting Sort allows sorting the 
modifiers or submodifiers according to any of the available 
fields such as Name, Code or Price. Selecting Style facili­
tates choice of font type, style, size, etc. To change the font 
in a particular window, click on View>Fonts or right mouse 
click in the desired window and then click on Fonts. To 
change the size of the windows, drag the borders of the 
windows to expand or contract the size of the windows. To 
change the column widths, simply drag the edge of the 
column headers to increase or decrease the column widths. 

A communications control program monitors and routes 
all communications to the appropriate devices. It continu­
ously monitors the wireless network access point and all 
other devices connected to the network such as pagers, 
remote devices, internet Web links and POS software. Any 
message received is decoded by the software, and then 
routed to the appropriate device. No user action is needed 
during operation of the software once the application has 
been launched To launch the communications control 
module, a Wireless Traffic icon is clicked on the desktop Pc. 
When the program loads, the screen shown in FIG. 6 
appears. Messages received are logged in the window 14 
shown in FIG. 6 with a time stamp. The messages are also 
logged to a file on the hard drive. This provides a mechanism 
to monitor all traffic across the network (possibly useful for 
troubleshooting, or maintenance, but not necessary for nor­
mal operation). The program may be minimized so the 
screen is not displayed on the desktop, but it must be running 
for proper communications to exist between all devices on 
the network. 

As stated, the preferred embodiment of the present inven­
tion includes the use of and compatibility with GUI tech­
nology. Adrag-and-drop approach is used for organizing the 
tree structure 2 in the generated menu. Drag-and-drop is also 
used for assigning modifiers (modifiers can be dragged from 
the modifiers window 5 and dropped onto the menu item 4 
for assignment). In-cell editing results in fast editing of 
items in building the menus. Customizable fonts enable 
users to change font types, style and size. Customizable 
layouts enable users to resize windows, change icons and 
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display preferences. The inventive approach provides for 
fully persistent storage between sessions, even if a session is 
improperly or abruptly terminated. Font and the tree state 
(i.e., which nodes are expanded/collapsed) are stored 
between sessions. Layout for modifiers and sub-modifiers 5 

list views (filter, columns, formatting, font, etc.) are stored 
between sessions. The last database used is likewise stored 
between sessions. Splitter views allow the user to see 
different views at the same time. Each view is displayed on 
its own section of the screen. Views can be resized via the 10 

keyboard or a mouse by simply dragging the splitter in the 
middle. 

12 
and modify, thus allowing for on time delivery of custom­
ized versions of the software. The advanced database func­
tions produce well-designed databases that accommodate 
growth and scalability. 

The inventive menu generation approach provides a solu­
tion for the pervasive connectivity and computerization 
needs of the restaurant and related markets. The inventive 
solution includes automatic database management and 
synchronization, PDA and handheld wireless operating sys­
tem integration and optimization, wireless communications 
and internet connectivity, user interface design, and graphics 
design. 

In the preferred embodiment, the menu generation 
approach of the present invention uses Windows CE® as the 

An automated function is provided to import existing POS 
databases into the inventive menu generation system and, as 
discussed above with respect to the detailed example of how 
to use the preferred embodiment, an automated download 
procedure is provided to transfer the desktop database onto 
a handheld device and/or Web page. Also as discussed, the 
preferred embodiment facilitates preview of the handheld 
device or Web page version of the POS menu on the desktop 
before downloading and configuration. Customizable desk­
top menu generation is contemplated, as discussed above, in 
the form of customizable fonts, columns, layouts, etc. The 
inventive approach also includes templates for common 
modifiers that can be assigned to similar menu items. The 
preferred embodiment also supports multiple databases, thus 
providing for the creation and storing of different menu 
databases on handheld devices such as breakfast, lunch or 
dinner menus. The user can then select the appropriate 
database to reflect the time of day. 

15 operating system for the handheld devices. Windows CE® 
provides the benefits of a familiar Windows 95/98/NT® 
look and feel, built-in synchronization between handheld 
devices, internet and desktop infrastructure, compatibility 
with Microsoft Exchange®, Microsoft Office 9® and TCP/ 

20 IP quick access to information with instant-on feature. 
Windows CE® provides a basic set of database and 

communication tools for developer use. However, interfac­
ing with these tools to provide application specific results 
can be a complex task. In addition to the menu generation 

25 described above, a set of software libraries described herein 
in conformance with the present invention not only enhances 
the basic Windows CE® functionality by adding new fea­
tures but also maximizes the full potential of wireless 
handheld computing devices. Such features include fast 

FIG. 7 is a schematic representation of a point of sale 
interface 15 for use in displaying a page-type menu 16 
created using the inventive menu generation approach. As 
can be seen from FIG. 7, the page menu is displayed in a 
catalogue-like point-and-click format whereas the master 
menu, FIG. 1, is displayed as a hierarchical tree structure. 
Thus, a person with little expertise can "page through" to 
complete a transaction with the POS interface and avoid 
having to review the entire menu of FIG. 1 to place an order. 
A PDA or Web page format could appear like FIG. 7 or the 
display could be configured for particular requirements since 
fully customizable menu generation and display are con­
templated. 

30 synchronization between a central database and multiple 
handheld devices, synchronization and communication 
between a Web server and multiple handheld devices, a 
well-defined API that enables third parties such as POS 
companies, affinity program companies and internet content 

35 providers to fully integrate with computerized hospitality 
applications, real-time communication over the internet with 
direct connections or regular modem dialup connections and 
support for batch processing that can be done periodically 
throughout the day to keep multiple sites in synch with the 

40 central database. 
The synchronous communications control module dis­

cussed above provides a single point of entry for all hospi­
tality applications to communicate with one another wire­
lessly or over the Web. This communications module is a 
layer that sits on top of any communication protocol and acts 
as an interface between hospitality applications and the 
communication protocol. This layer can be easily updated to 
work with a new communication protocol without having to 
modify the core hospitality applications. The single point of 

The POS interface on the handheld device supports pric­
ing in the database or querying prices from the POS server. 45 

The POS device also can be customized with respect to 
"look and feel" for the particular version. As can be seen in 
FIG. 7, the POS interface provides for billing, status and 
payment with respect to orders. A myriad of options can be 
provided depending on the application. 50 entry works to keep all wireless handheld devices and linked 

Web sites in synch with the backoffice server (central 
database) so that the different components are in equilibrium 
at any given time and an overall consistency is achieved. For 

Advanced database functions are provided in the pre­
ferred embodiment of the invention, including an automated 
download process onto handheld devices and/or Web sites. 
In the preferred embodiment, the menu generation system of 
the present invention uses an API called ActiveX Data 55 

Objects ("ADO") for database access. ADO is useful in a 
variety of settings. It is built on top of OLE DB and can be 
used to talk to databases and, in the future, any data source 
with any OLE DB driver. Advanced querying is supported. 
The database can be queried on virtually all fields. Queries 60 

can be built using SQL syntax for experienced users or can 
be created using a query builder which guides users through 
the creating process. Advanced error handling is supported. 
Errors occurring at run time can be trapped. A descriptive 
message is displayed to alert the user and provide error 65 

information. However, the application does not terminate 
when the errors happen. The source code is easy to maintain 

example, a reservation made online is automatically com­
municated to the backoffice server which then synchronizes 
with all the wireless handheld devices wirelessly. Similarly, 
changes made on any of the wireless handheld devices will 
be reflected instantaneously on the backoffice server and the 
other handheld devices. 

The software applications for performing the functions 
falling within the described invention can be written in any 
commonly used computer language. The discrete program­
ming steps are commonly known and thus programming 
details are not necessary to a full description of the inven­
tion. 

A simple point-to-point wireless capability is contem­
plated which permits simple digital messages to be sent from 
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the wireless handheld devices to a receiver in a beeper 
and/or valet parking base-station. The POS interface of FIG. 

14 
images and descriptions of merchandise. The user may 
conventionally search for an item by entering a key word 
search query in a box on a form. When a user selects an item, 
the server may provide a linked form that describes that item 

5 in further detail. The user may also conventionally enter 
ordering information into boxes on the form, such as the 
type and quantity of the item desired. The information 
entered by the user is transmitted to the server. The user may 
select multiple items in this manner and then enter a credit 

7 is representative of the display on a typical wireless device 
used in conformity with the invention. A simple protocol is 
used to acknowledge receipt of the message and thus simul­
taneous communication is not necessary, which reduces the 
cost of the wireless link. The range of the wireless link is 
determined by the characteristics of the radio transceiver. 
Adding a wireless link allows paging of beeper equipped 
customers directly from the operator interface on the wire­
less handheld devices and communication to and from 
various input/output transmitters and receivers to update the 
status of the order, reservation or other information and thus 
further reduce the workload on the operator and enable 
operations to proceed much faster. This link could also be 15 

hardwired or otherwise implemented using any two-way 

10 card number to pay for the purchases. The retailer processes 
the transaction and ships the order to the customer. As can 
be appreciated, ordering merchandise can also be done from 
menus. The generation of menus of items or merchandise for 
sale over the internet is readily accomplished by the menu 
generation approach of the present invention. 

Searching for items that the user is interested in purchas-
ing is insufficient in prior merchandising systems. Database 
management programs use index searching to facilitate rapid 
searching of large amounts of data. The creator of the 
database may instruct the program to use specified fields in 

messaging transport. 
A further aspect of the invention is the use of the menus 

generated in accordance with the described technique to 
place orders from wireless remote handheld devices or from 
remote locations through the internet. The World Wide Web 

20 the database as indexed or key fields. The program locates 
all terms in the database that appear in the indexed fields and 
stores them in an index table. Each entry in the index table 
includes a term and corresponding pointer to the location in 
the database where the term is found. If a user initiates a 

is a distributed hypermedia computer system that uses the 
internet to facilitate global hypermedia communication 
using specified protocols. One such protocol is the Hyper­
text Transfer Protocol ("HTTP"), which facilitates commu- 25 

nication of hypertext Hypertext is the combination of infor­
mation and links to other information. In the context of the 
Web, hypertext is defined by the Hypertext Mark-up Lan­
guage ("HTML"). The links or hyperlinks in a HTML 
document reference the locations of resources on the Web, 
such as other HTML documents. Another language used in 
creating documents for use on the Worldwide Web, to 
display on computer screens, or to create speech style sheets 
for use in, e.g., telephones, is the Extensible Mark-Up 
Language ("XML"). XML is a "metalanguage", i.e., a 35 

language for describing languages which was developed to 
eliminate the restrictions of HTML. 

search for a term that is present in the index table, the 
program can locate the instances of that term in the database 
with exceptional speed. Users who are familiar with the 
particular database they are searching will generally know 
which fields are indexed and will know the format of the 

30 data in those fields. For example, a user of a database 
containing the inventory of a bookstore may know that users 
can search for the names of authors of books and that a user 
who wishes to do so should enter the author's last name first. 
A user having such knowledge will therefore be able to 
search efficiently. Users of electronic merchandising 
systems, however, are generally end-consumers who have 
no knowledge of a merchant's database. If, as is very likely, 
such a user initiates a search for a term that is not present in 
the index table, the program must sequentially search 

The Web is a client-server system. The HTML documents 
are stored on Web server computers, typically in a hierar­
chical fashion with the root document being referred to as 
the home page. The client specifies a HTML document or 
other source on the server by transmitting a Uniform 
Resource Locator ("URL") which specifies the protocol to 
use, e.g., HTTP, the path to the server directory in which the 
resource is located, and filename of the resource. Users 
retrieve the documents via client computers. The software 
running on the user's client computer that enables the user 
to view HTML documents on the computer's video monitor 
and enter selections using the computer's keyboard and 
mouse is known as a browser. The browser typically 
includes a window in which the user may type a URL. A user 
may cause a URL to be transmitted by typing it in the 
designated window on the browser or by maneuvering the 
cursor to a position on the displayed document that corre­
sponds to a hyperlink to a resource and actuating the mouse 
button. The latter method is commonly referred to simply as 
"clicking on the hot-spot" or "clicking on the hyperlink". 
The hyperlink methodology is contemplated for use in 
accordance with the preferred embodiment to transmit 
orders via the internet. 

Web server application software exists that enables a user 

40 through all records in the database. Sequential records are 
typically linked by pointers. Using pointers in this manner is 
very demanding on server resources, resulting not only in an 
exceptionally slow search, but also creating a bottleneck for 
other processes that the server may be executing. The menu 

45 generation approach of the present invention can be used to 
create customized menus from a database that includes 
every item of merchandise the vendor has for sale. In this 
manner, customers can scan the generated menu much more 
readily than they could view the entire database and the 

50 necessity of having familiarity with the database is elimi­
nated as well, reducing the need for resource intensive 
pointers. 

While the preferred embodiment of the invention is for 
the generation of restaurant menus and the like, the broad 

55 scope of the invention is far greater. For example, menus 
generated in accordance with the invention can be used in 
the desktop computing environment in association with the 
operating system or application programs. One such use is 
to facilitate the creation of user personalized file structures 

60 for general desktop use. Another use is to facilitate the 
location of customized menus from master menus for use in 

to shop for and order merchandise. Such systems are some­
times referred to as electronic merchandising systems or 
virtual storefronts. Systems that enable a user to choose 
among several retailers' goods are sometimes referred to as 65 

electronic malls. An electronic retailer's or electronic mall 
operator's Web server provides HTML forms that include 

association with application software to make the execution 
of the application software more efficient by, e.g., eliminat­
ing the necessity of querying or checking every tree branch 
in the master menu file structure in response to user input or 
other criteria and to create handheldlPDA compatible ver­
sions of the software. 
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While the preferred embodiment of the invention includes 
the selection of items from a master menu wherein the 
master menu is displayed using a graphical user interface, it 
is to be appreciated that any means for displaying the master 
menu to the user and generating another menu in response 5 
to and comprised of the selections made is encompassed by 
the contemplated invention. The invention encompasses the 
selection of nontextual symbols, characters, icons and the 
like, in addition to text, from a hierarchical tree menu or the 
like for generation of another menu comprised of such items. 

It is also within the scope of the invention to generate 10 
menus automatically in response to predetermined criteria. 
For example, in the restaurant menu generation 
embodiment, a modified menu can be generated to comply 
with a particular specification or group of criteria such as, 

~~tic~:~~~~~r::~e;~~:ia~~.oi~St~i~0~~b~1~:e!t~t~~I;'ft~~~ 15 

from the master menu that satisfy specified parameters will 
be included in the generated menu. The selection process 
could involve selection of master menu items based on tags 
or identifiers associated with the items or by checking every 
master menu item against a dictionary of items acceptable 20 

for inclusion in the modified menu. It should also be 
appreciated that the invention encompasses any combination 
of automatic and manual user selection of the items com­
prising the generated menu. For example, a user might 
specify criteria which would further control automatic selec- 25 

tion or the user could manually select some items with 
automatic selection of others. The menu generation aspect of 
the invention is equally applicable to table-based, drive-thru, 
internet, telephone, wireless or other modes of customer 
order entry, as is the synchronous communications aspect of 
the invention. 30 

The inventive concept encompasses the generation of a 
menu in any context known to those skilled in the art where 
an objective is to facilitate display of the menu so as to 
enable selection of items from that menu. The restaurant 
menu generation embodiment is but one example of a use for 35 

the inventive concept. Likewise, displaying menus gener­
ated in accordance with the invention on PDAs and Web 
pages to facilitate remote ordering are but a few examples of 
ways in which such a menu might be used in practice. Any 
display and transmission means known to those skilled in 40 

the art is equally usable with respect to menus generated in 
accordance with the claimed invention. 

In the more general situation, menus can be generated in 
accordance with the present invention in a variety of situ­
ations. For example, the usable file structure for a particular 45 

data processing application can be dictated by the user or an 
application program prior to or during the execution of the 
application program. Efficiencies with respect to computa­
tional speed and equipment, e.g., storage and processor, 
usage can thus be achieved along with the facilitation of 
display of the generated menu. 50 
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d. a first menu consisting of menu categories, said menu 

categories consisting of menu items, said first menu 
stored on said data storage device and displayable in a 
window of said graphical user interface in a hierarchi­
cal tree format, 

e. a modifier menu stored on said data storage device and 
displayable in a window of said graphical user 
interface, 

f. a sub-modifier menu stored on said data storage device 
and displayable in a window of said graphical user 
interface, and 

g. application software for generating a second menu 
from said first menu and transmitting said second menu 
to a wireless handheld computing device or Web page, 

wherein the application software facilitates the generation 
of the second menu by allowing selection of categories 
and items from the first menu, addition of menu cat­
egories to the second menu, addition of menu items to 
the second menu and assignment of parameters to items 
in the second menu using the graphical user interface of 
said operating system, said parameters being selected 
from the modifier and sub-modifier menus, wherein 
said second menu is manually modified after genera-
tion. 

2. The system of claim 1 wherein the modified second 
menu can be selectively printed on any printer directly from 
the graphical user interface of a hand-held device. 

3. The system of claim 1 wherein the modified second 
menu can be linked to a specific customer at a specific table 
directly from the graphical user interface of a hand-held 
device. 

4. An information management and synchronous commu­
nications system for generating menus comprising: 

a. a central processing unit, 
b. a data storage device connected to said central pro­

cessing unit, 
c. an operating system including a graphical user 

interface, 
d. a first menu stored on said data storage device, 
e. application software for generating a second menu from 

said first menu, 
wherein the application software facilitates the generation 

of the second menu by allowing selection of items from 
the first menu, addition of items to the second menu and 
assignment of parameters to items in the second menu 
using the graphical user interface of said operating 
system and wherein data comprising the second menu 
is synchronized between the data storage device con­
nected to the central processing unit and at least one 
other computing device, wherein said second menu is 
manually modified by handwriting or voice recording 
after generation. 

While the best mode for carrying out the preferred 
embodiment of the invention has been illustrated and 
described in detail, those familiar with the art to which the 
invention relates will recognize various alternative designs 
and embodiments which fall within the spirit of practicing 
the invention. The appended claims are intended to cover all 
those changes and modifications falling within the true spirit 
and scope of the present invention. 

5. An information management and synchronous commu-
55 nications system for generating menus comprising: 

That which is claimed is: 
1. An information management and synchronous commu- 60 

nications system for generating and transmitting menus 
comprising: 

a. a central processing unit, 
b. a data storage device connected to said central pro­

cessing unit, 
c. an operating 

interface, 
system including a graphical user 

65 

a. a microprocessor, 
b. a display device, 
c. a data and instruction input device, 
d. a data storage device for storing information and 

instructions entered through said data and instruction 
input means or information generated by said 
microprocessor, 

e. an operating system, 
f. a master menu stored on said data storage device for 

generating a modified menu, and 
g. application software, 
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wherein said microprocessor, operating system and applica­
tion software are operative to display the master menu on the 
display device in response to instructions programmed into 
said microprocessor, operating system, application software 
and information and instructions entered through said data 5 

input device, and wherein said microprocessor, operating 
system and application software are operative to create the 
modified menu from said master menu in response to 
information and instructions entered through said data and 
instruction input device and wherein data comprising the 10 

modified menu is synchronized between the data storage 
device and at least one other computing device, wherein said 
modified menu is manually modified after generation. 

6. The information management and synchronous com­
munications system of claim 1, 4, or 5 wherein the manual 15 
modification involves handwriting capture. 

7. The system of claim 6 wherein the handwriting capture 
involves handwriting recognition and conversion to text. 

8. The information management and synchronous com­
munications system of claim 1, 4, or 5 wherein the manual 20 

modification involves voice capture. 
9. The system of claim 8 wherein the voice capture 

involves voice recognition and conversion to text. 
10. The system of claim 4 or 5 wherein the modified 

second menu can be selectively printed on any printer 
directly from the graphical user interface of said other 25 

computing device. 
11. The system of claim 4 or 5 wherein the modified 

second menu can be linked to a specific customer at a 
specific table directly from the graphical user interface of 
said other computing device. 30 

12. In a computer system having an input device, a storage 
device, a video display, an operating system including a 
graphical user interface and application software, an infor-
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mation management and synchronous communications 
method comprising the steps of: 

a. outputting at least one window on the video display; 

b. outputting a fist menu in a window on the video display; 

c. displaying a cursor on the video display; 

d. selecting items from the first menu with the input 
device or the graphical user interface; 

e. inserting the items selected from the first menu into a 
second menu, the second menu being output in a 
window; 

f. optionally adding additional items not included in the 
first menu to the second menu using the input device or 
the graphical user interface; 

g. storing the second menu on the storage device; and 

synchronizing the data comprising the second menu 
between the storage device and at least one other data 
storage medium, wherein the other data storage 
medium is connected to or is part of a different com­
puting device, and wherein said second menu is manu­
ally modified after generation. 

13. The method of claim 12 wherein the manual modifi­
cation involves handwriting capture. 

14. The method of claim 13 wherein the handwriting 
capture involves handwriting recognition and conversion to 
text. 

15. The method of claim 12 wherein the manual modifi­
cation involves voice capture. 

16. The method of claim 15 wherein the voice capture 
involves voice recognition and conversion to text. 

* * * * * 


